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E X E R C I S E  1

Simulating a Dropping Coin

This first exercise in Working Model 3D introduces you to its most 
fundamental features: modeling and running.

You will create a model of a coin dropping to the ground, then learn 
about running and stopping a simulation, manipulating your view of the 
model, and exporting the simulation to a Video for windows file. You 
will also analyze the motion of the model using vectors to display key 
properties as the simulation runs.
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1.1 Starting Working Model 3D

To start Working Model 3D:

1. Launch the Working Model 3D program.

Working Model 3D starts and presents a blank document window, 
as shown in Figure 1-1.

Figure 1-1

Working Model 3D with a Blank 
document window

2. Choose Show Grid in the Grid menu.

The Edit Grid appears in the window, as shown in Figure 1-2.

Cylinder Tool

Toolbars
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Figure 1-2

The Edit Grid

1.2 Drawing the Coin

You will create a coin in the document.

1. Click the Cylinder tool on the Sketch toolbar.

The Cylinder tool icon appears indented to show that the tool is 
currently selected.

2. Position the pointer anywhere on the Edit Grid and click the 
mouse button. Then move the mouse to expand the circle.

As you move the mouse, a circle appears on the Edit Grid.  Note that 
the circle expands from the center, and the dimension of the circle 
“snaps” to the grid units.

3. Move the mouse around until the diameter of the circle reaches 
0.2 or 0.3 meters, then click the mouse button.

Notice how the coordinates bar shows the extent of the circle, as 
shown in Figure 1-3.
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Figure 1-3

Drawing a Coin

By clicking a second time you have completed the profile of the cylinder. 
You will now extrude the circle up or down to complete the cylinder.

4. Move the mouse upwards slightly to extrude the circle. Click the 
mouse button once again to complete.

Again, notice how the mouse movement snaps to the grid units, 
resulting in a “jumpy” shift of the cylinder height.

Coordinates bar
shows the circle 
extent
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Figure 1-4

Completed Coin

Also, note that the coin has a set of axes to represent the local coordinate 
system, as shown in Figure 1-4. The coordinate origin coincides with the 
geometric center of the body.

1.3 Positioning the Coin

Initially the coin rests on the xy plane.  You will move the coin away 
from the plane, and rotate it slightly.

1. Double-click the coin in the document window or in the Object 
List that runs along the left edge of the window.

The Properties window appears, as shown in Figure 1-5. This 
window “floats” above other windows and displays information 
about the selected objects.

Local Coordinate System for the Cylinder
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Figure 1-5

Properties Window

2. Change the z-position of the coin by typing “0.3” into the “Z” 
edit box, then press Enter.

Notice that the coin moves upwards immediately.

The body position is represented as the position of the coordinate origin 
of the cylinder in the global coordinates.  The coordinate origin of the 
cylinder coincides with the geometric center of the cylinder.

3. Change the orientation of the coin by typing 20 into the Rx edit 
box.  Press Enter.

The coin rotates by 20 degrees (see Figure 1-6) about the body’s x-
axis.

Working Model 3D expresses the orientation of the body in the local 
coordinate system, using body XYZ angles. Exercise 5, “Modeling a 
Gyroscope Top”, discusses the body XYZ angle representation in more 
detail. For now, it suffices to say that the body orientation is expressed in 
terms of a series of rotations about its axes.

Figure 1-6

Rotated Coin

Type 0.3 here (Z-position)

Type 20 here (Rx Rotation)
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4. Close the Properties window.

5. Click the blank area of the screen.

The thick edges disappear (see Figure 1-7).

Figure 1-7

Selection Handles

When you select a body, the edges thicken, as shown in Figure 1-7, to 
indicate that the body is selected and the local coordinate system 
becomes visible.

When you deselect a body, the edges become thin again and the local 
coordinate system becomes invisible.

When you move the mouse over a body, the bounding box becomes 
visible to show which body will be selected if you click now.

Selected

Not selected

Bounding Box
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Stepping Back in View

Currently, your document window shows the coin and a portion of the 
Edit Grid. To observe the dropping coin later, you will “step back” to get 
a bigger picture.

1. Click the Zoom In/Out tool on the View toolbar.

The mouse cursor turns into the Zoom icon.

2. Click near the origin of the coordinate axes, hold down the 
mouse button, then move the mouse up and down.

Observe that the document view changes as if you are stepping 
backward (as you move the mouse up) and forward (as you move the 
mouse down).

3. When the entire Edit Grid is visible, release the mouse button.

Your view may resemble Figure 1-8. If the Edit Grid does not appear 
to be centered, proceed to the next step.

Figure 1-8

Centered Edit Grid

4. If the Edit Grid does not appear to be centered, click the Pan 
tool.

The mouse cursor turns into the Pan icon.
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5. Click anywhere in the document, hold down the mouse button, 
and drag the mouse.

Observe that the entire “scene” pans in the direction of the mouse 
movement.

6. Repeat the panning as necessary until your view resembles 
Figure 1-8.

1.4 Creating a Ground Plane

You will now create a simple table-top for the coin to fall on.

1. Choose Ground Plane in the World menu.

A large flat body appears just beneath the cylinder (Figure 1-9).

Figure 1-9

Ground Plane

Working Model 3D automatically sizes the Ground Plane based on the 
maximum (x, y) extent of the bodies in the document. The top surface of 
the plane is always at z = 0. Also, the Ground Plane is anchored such that 
it does not move relative to the background.

Bodies will pass through each other unless you specify that they should 
collide.  The following steps will make the coin collide with the table.

2. Choose Select All in the Edit menu.

Both the coin and the ground plane are selected.

Ground Plane
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3. Choose Collide in the Object menu.

The selected objects will now collide when you run. 

Note: When you select a body in the Object List that runs along the left 
edge of the document window, the other objects in the simulation that are 
set to collide with it are displayed in the Connections List with a special 
“collision” icon, as shown in Figure 1-10.

Figure 1-10

Collision Icon in the Connections 
List

1.5 Running the Simulation

You are now ready to watch the coin drop and hit the table.

1. Click the Run button in the Tape Player Control at the bottom left 
corner of the document window.

The coin falls, hits the table, and bounces a few times (Figure 1-11). 
The Frame Counter and Time Meter, also located at the bottom of 
the window, inform you of the progress.

Collision Icon
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Figure 1-11

Bouncing Coin

2. Click the Reset button in the Tape Player Control.

The coin  returns to its original position.

1.6 Adding Shading to the Bodies

Working Model 3D has a built-in rendering capability to add a far greater 
realism to the image compared to the wireframe rendering.

1. Choose Shaded in the View menu.

The green coin and the grey Ground Plane appear shaded, as shown 
in Figure 1-12.

Frame Counter Time Meter
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Figure 1-12

Shaded Image

2. Click the Run button in the Tape Player Control.

The simulation runs with the shaded coin.

3. Click the Reset button after running for a few dozen frames.

NOTE: When two objects become very close to each other, you may 
notice broken lines or fuzzy edges. Working Model 3D’s graphic 
rendering system is optimized for smooth, rapid animation of shaded 
objects so that it works on both 16-bit and 32-bit systems. The graphic 
irregularity is a byproduct of the optimization and does not affect the 
simulation computation at all.

1.7 Navigating the World

This section introduces you to the versatile graphics manipulation 
capabilities of Working Model 3D. You can gain a better understanding 
of your model when looking at it from various view angles. In addition, 
the motion associated with the changing view provides a powerful depth 
cue, especially in the perspective mode, because objects appear to move 
at different rates depending on where they are located in the three-
dimensional space.

1. Click the Pan tool on the View toolbar, or press F2 on the 
keyboard.

The mouse cursor changes to the Pan tool.
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2. Click anywhere in the workspace and drag the mouse to the 
right.

As you drag the mouse to the right, the view shifts accordingly.

3. Press “P” on the keyboard.

Pressing “P” on the keyboard is equivalent to choosing Previous in 
the View menu. Your view jumps back to the previous position.

4. Click the Zoom In/Out tool on the View toolbar, or press F3 on 
the keyboard.

The mouse cursor changes to the Zoom tool.

5. Click anywhere on the coin and drag the mouse upwards.

As you move the mouse down, the view is zoomed in. Moving the 
mouse up zooms out.

6. Click the Rotate Around tool on the View toolbar, or press F4 on 
the keyboard.

The Rotate Around tool becomes selected, and a dotted line circle 
appears around the center of the coin.

7. Click anywhere inside the circle, and drag the mouse around.

As you drag the mouse around, your view rotates around the center 
of the circle. This tool is a very powerful way to change your view 
and it also provides useful depth cues through motion. 

8. Press F on the keyboard.

Pressing F on the keyboard is equivalent to choosing the menu item 
View->Look At->Front View. Your view jumps to a front view of 
your model.
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Working Model 3D provides six shortcuts to view the model in 
predefined directions. You can access the views in the following 
directions with the corresponding shortcut key.

You can also set a favorite or “Home” view and quickly return to it, or 
zoom out to see the entire model with these shortcut keys.

9. Click the Toggle Isometric button in the View toolbar, or choose 
Isometric in the View menu.

The drawing window displays an isometric projection, as shown in 
Figure 1-13. 

Although the isometric projection appears to have less depth cues 
than the perspective projection, you can verify alignments of bodies 
and components, especially using one of the head-on views.

View from Shortcut Key

Front (positive X) F

Back (negative X) B

Top (positive Z) T

Bottom (negative Z) M

Right (positive Y) R

Left (negative Y) L

View Shortcut Key

Set Home S

Go Home G

View All V

Previous View P
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Figure 1-13

Isometric Projection

10. Choose Perspective in the View menu.

Your view changes back to a “3D” perspective.

11. Click the Run button in the Tape Player Control and then use the 
view manipulation tools while the simulation is running.

You can change your view, zoom in on objects, rotate around the 
world, and so forth while the simulation is running.

12. Click the Reset button after running for a few dozen frames.

1.8 Analyzing the Simulation

This section introduces you to a few of the many analysis tools available 
in Working Model 3D.You can gain insights into the motion being 
simulated and the forces at work by:

• displaying vectors while the simulation is running 

• adding meters that measure values you want to track

Displaying a Velocity Vector on the Coin

In this step, you will display a vector that will show the velocity of the 
coin as the simulation runs.
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1. Double-click the coin in the document window or in the Object 
List that runs along the left edge of the window.

The Properties window appears.

2. Click the right arrow in the Properties window to scroll the tabs 
until the Vectors tab is visible. Then click the Vectors tab.

The Vectors page is displayed, as shown in Figure 1-14.

Figure 1-14

Properties Window (Vectors Page) 
for the Coin

3. Click the Velocity Vector box to put a checkmark in it.

4. Click the Zoom In/Out tool on the View toolbar.

The mouse cursor changes to the Zoom tool.

5. Click anywhere on the coin and drag the mouse downwards to 
zoom in closer.

6.  Click the Run button in the Tape Player Control.

As the simulation runs, the velocity vector is displayed on the coin 
as shown in Figure 1-15.
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Figure 1-15

Velocity Vector on Coin

7. Click the Stop button, then reset the simulation by clicking the 
Reset button.

1.9 Saving a File

To save your coin drop simulation to a file:

1. Choose Save in the File menu.

The Save As dialog appears (Figure 1-16).

Figure 1-16

Save As Dialog
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2. Choose a directory to which you would like to save the file.

3. Type COINDROP in the File name edit box.

Working Model 3D automatically adds an extension WM3 to the 
filename.  Therefore, the file is saved as COINDROP.WM3.

4. Click Save.

The simulation history is saved as well as the model data. When you open 
the file next time, you can click the Run button to play back the 
simulation without waiting for Working Model 3D to compute every 
frame.

1.10 Exporting a Video for Windows (AVI) File

Your Working Model 3D simulation is a great way for people to 
visualize your ideas. To demonstrate the coin drop simulation, you can 
reopen the file at a later time and play it back; however, you must assume 
that the Working Model 3D application is available where you want to 
show the demonstration.

Instead, you can save the simulation file in the Video for Windows 
format—a common format for animation files under Windows—and 
distribute the “video” file. Anyone who has a Windows PC can play back 
the file. In fact, Working Model 3D simulations will play back more 
quickly as Video for Windows movies.

To export the simulation as a Video for Windows file:

1. Using the Pan, Zoom In/Out, and Rotate Around tools, arrange 
the view.

The Video for Windows file will record the simulation exactly as it 
appears in the Working Model 3D document window. Make sure to 
“prepare the scene” before you start exporting.

2. Choose Export Video in the File menu.

The Export Video dialog appears (Figure 1-17). Note that Working 
Model 3D automatically defines the first and last frame numbers 
according to the existing simulation history.
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Figure 1-17

Export Video Dialog

3. Type COINDROP in the File name edit box.

4. Click Save.

Working Model 3D starts to run each frame to export. After the last 
frame, a dialog appears to report that exporting has finished.

Working Model 3D saves an AVI file exactly the way the running 
simulation appears in the document window, including the pixel size of 
the window. However, the toolbar, menus, tape controls, status bar, and 
coordinates bar are not saved in the AVI file.

To play back the AVI file, simply double click on the AVI file from the 
Windows File Manager or Explorer. You can start, stop, or pause the 
video with the controls in the video window, as shown in Figure 1-18.
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Figure 1-18

AVI File Playback

NOTE: The Windows Media Player may not handle very large AVI 
files.  If you experience a problem while playing back, try the Video for 
Windows export again with a reduced window size or number of frames.

1.11 Hints for Faster Animation

Here are some guidelines to speed up the Working Model 3D animation 
(playback and editing).

• Use a small window size.  The fewer pixels Working Model 3D 
needs to draw, the faster the rendering becomes.  The same goes for 
the AVI file rendering.

• Use wireframe mode while editing. This option is turned on by 
default under the View menu. When you drag or resize objects, this 
option speeds up the editing.



2-1
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Analyzing a Piston Model

This exercise illustrates how you use Working Model 3D to immediately 
start analyzing the performance characteristics (reaction forces, collision 
and part interference) and test what-if scenarios on a model of a piston 
assembly. It walks you through the full range of analytical features 
available in Working Model 3D.

The piston model that you analyze could have been created by:

• exporting a model from your favorite CAD software. For more 
information on exporting CAD models, see Exercise 3, “Exploring 
CAD Integration and Associativity”.

• building a model from scratch in Working Model 3D. For more 
information on building models, see Exercise 4, “Creating a Piston 
Model”.
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2.1 Opening a Model File
1. Open the file “Piston.wm3” located in your “Program 

Files\Working Model 3D\Tutorials\Exercise 2” directory. 

The folder path may vary depending on where you installed Working 
Model 3D. 

The model of the piston assembly is displayed in the document 
window, as shown in Figure 2-1.

Figure 2-1

Model of a Piston Assembly

2. Click the Run button in the Tape Player Control.

This base model shows the piston mechanism in motion, driven by 
the motor attached to the crankshaft.

Since this is the first time the simulation is being run, Working 
Model 3D calculates the dynamics and stores the data. 

3. Repeat the simulation by clicking the Stop button, then the 
Reset button, and then the Run button again.

The animation is faster this time because the history has already 
been calculated.
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2.2 Understanding Part Relationships

You can see how the parts of the model are connected by selecting them 
in the Object Manager that appears along the left edge of the document 
window, as shown in Figure 2-2. 

• When you select a body in the Object List or the Connections List, 
all of the constraints and Coords connected to that body are 
displayed in the Connections List.

• When you select a constraint in the Object List or the Connections 
List, all of the bodies and Coords connected to that constraint are 
displayed in the Connections List.

• When you select a Coord in the Object List or the Connections List, 
all of the bodies and constraints connected to that Coord are 
displayed in the Connections List.

NOTE: Objects that have been hidden in the drawing appear with 
dimmed icons in the Object List and Connections List. Although they are 
hidden, they are still active in the simulation, and you can select them in 
the lists.

Figure 2-2

Object List and Connections List

Selected constraint

Bodies and Coords
connected to the
selected constraint

Move this bar
up or down
to resize the
Connections
List
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1. Select “Piston_Head_par_1” in the Object List.

The constraints and Coords connected to the piston head are 
displayed in the Connections List.

2. Select “constraint[40]” in the Connections List.

The Connections List now shows that constraint [40] connects the 
piston head, “Pistion_Head_par_1”, to the piston pin, 
“Piston_Pin_par_1”. 

3. Double-click constraint[40]” in the Connections list.

The Properties window displays the properties of “constraint[40]”, 
as shown in Figure 2-3.

Figure 2-3

Properties Window
for constraint[40]

4. Select a few other objects in the Object list.

As you select each object, it is highlighted in the drawing window 
and its properties are displayed in the Properties window.

2.3 Setting the Initial Condition 

Working Model 3D allows you to manipulate and configure parts 
without breaking the assembly constraints that were created when the 
model was built in Working Model 3D or in the CAD system. In this step, 
you will move the piston assembly’s configuration so that the simulation 
starts halfway through the combustion or compression cycle.

1. Click the Move tool in the Edit toolbar.
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2. Move the mouse over the side surface of the crankshaft 
counterweight in the drawing window. 

As you move the mouse over objects in the drawing window, a 
dashed box appears around them to show that they are selected, as 
shown in Figure 2-4.

Figure 2-4

Bounding Box Showing Selected 
Object

3. Hold the mouse button down, and drag the mouse to rotate the 
crankshaft.

As you drag the mouse, the crank rotates around the crank pin.

4. Position the crankshaft so that the piston is halfway through the 
full stroke, as shown in Figure 2-5.
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Figure 2-5

Piston Rotated Halfway through
the Full Stroke

You can change the configuration by using the Move tool to drag any of 
the moving parts in the model. Try dragging the piston head or the 
connecting rod.

NOTE: The movement stops when the parts are dragged to the 
mechanical limits imposed by the physical joints.

5. Click the Run button in the Tape Player Control.

The simulation runs again, starting from its new initial position.

6. Click the Stop button, then reset the simulation by clicking the 
Reset button.

The piston assembly returns to the new initial position, halfway 
through the full stroke.

2.4 Running a Simulation Interactively

You can add input sliders to dynamically change the properties of a 
constraint as the simulation is running. In this step, you will add an input 
slider that controls the angular velocity of the motor that turns the 
piston’s crank.

1. Select the revolute motor, “constraint[10]” in the Object List.
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The revolute motor is selected (even though it may not be visible in 
the drawing window).

2. Choose Create Input in the Object menu, then choose 
Rotational Velocity in the submenu that appears.

An input slider window appears above the drawing window with the 
title “Rot. Velocity of constraint [10]”, as shown in Figure 2-6. 

Figure 2-6

New Input Slider for Rotational 
Velocity of Motor

3. Select the input slider, then choose Properties in the Edit menu.

The input slider’s properties appear in the Properties window.

4. Click the Appearance tab in the Properties window, then enter 
“Motor Rotational Velocity” as the name for this input slider, as 
shown in Figure 2-7.

The new name appears as the title of the input slider window.
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Figure 2-7

Properties Window 
(Appearance Page) for Input Slider

5. Click the Input tab in the Properties window, then enter “0” as 
the minimum value for the input range and “3600” as the 
maximum value, as shown in Figure 2-8.

The numbers are interpreted in degrees per second.

Figure 2-8

Properties Window 
(Input Page) for Input Slider

6. Click the Run button in the Tape Player Control.

7. As the simulation runs, try dragging the input slider to higher 
and lower values.

As you drag the slider to the right, the angular velocity of the motor 
increases and the crank rotates more quickly. Conversely, as you 
drag the slider to the left, the crank rotates more slowly.

8. Click the Stop button, then reset the simulation by clicking the 
Reset button.

The piston assembly returns to the initial position, halfway through 
the full stroke.
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9. Click the close box in the input slider window.

The input slider is still available in the Object List, but it is 
temporarily hidden from view. You can redisplay the input slider by 
double-clicking it in the Object List.

2.5 Measuring Reaction Forces

You can add meters to the model to measure the reaction forces in the 
piston assembly. For example, in this step, you will create a meter to 
measure the constraint force experienced by the revolute joint between 
the connecting rod and the piston pin.

1. Select “Piston_Pin_par_1” in the Object List.

The list of constraints and Coords connected to the piston pin 
appears in the Connections list.

2. Select “constraint[34]”, the revolute joint that connects the 
connecting rod to the piston pin, in the Connections List.

Note that “coord[32]” is listed as one of the Coords attached to 
“constraint[34]” in the Connections list. 

3. Choose Force on Connecting_Rod_par_1 expressed in 
coord[32] in the Measure menu.

A new meter window opens, titled “constraint[34] force on coord 
[32]”, as shown in Figure 2-9. The new meter will display the x, y, 
and z components and the total constraint force exerted by 
constraint[34] on coord[32] as separate plots by default.
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Figure 2-9

Constraint Force Meter Window

4.  Click the Run button in the Tape Player Control.

As the simulation runs, the values of the x, y, and z components and 
the total constraint force between the piston pin and the connecting 
rod is plotted in the meter window. Notice how Fx and Fy oscillate 
as the crank rotates through a full stroke, as shown in Figure 2-10.

Figure 2-10

Constraint Force Meter Window
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NOTE: Your results may not match Figure 2-10. The appearance of the 
plots depends upon the Motor Rotational Velocity that you select with 
the input slider.

5. Click the Stop button, then reset the simulation by clicking the 
Reset button.

The piston assembly returns to the initial position.

6. Click the close box in the meter window.

The meter is still available in the Object List, but it is temporarily 
hidden from view. You can redisplay the meter by double-clicking it 
in the Object List.

2.6 Visualizing Dynamics with Vectors

Working Model 3D allows you to visualize vectors in 3D space as the 
simulation runs. Although the animated simulation itself serves as a 
powerful visualization tool, hard-to-see qualitative data such as vectors 
reveal even more information that can’t be seen in a physical prototype. 

Display the Acceleration of the Connecting Rod

In this step, you will display vectors that show the acceleration of the 
connecting rod.

1. Double-click “Connecting_Rod_par_1” in the Object List.

The connecting rod’s properties appear in the Properties window.

2. Click the right arrow in the Properties window to scroll the tabs 
until the Vectors tab is displayed, then click the Vectors tab.

The Vectors page is displayed, as shown in Figure 2-11.
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Figure 2-11

Properties Window 
(Vectors Page) for the Connecting 
Rod

3. Click the Acceleration Vector box to put a checkmark in it.

4. Click the Toggle Wireframe button in the View toolbar.

The drawing window changes to a wireframe rendering, which will 
make it easier for you to see the acceleration vector (which is often 
hidden by the sides of the crank) as the simulation runs. 

5.  Click the Run button in the Tape Player Control.

As the simulation runs, the acceleration vector is displayed, but it is 
difficult to see because it is small. In the next step, you will resize the 
acceleration vector to make it easier to see.

6. Click the Stop button, then reset the simulation by clicking the 
Reset button.

The piston assembly returns to the initial position.

Make the Acceleration Vector More Visible

You can change the size and color of the vectors displayed to make them 
more visible as the simulation runs.

1. Choose Vector Display in the View menu.

The Vector Settings dialog appears, as shown in Figure 2-12.
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Figure 2-12

Vector Settings Dialog

2. Enter 0.09 as the scaling factor for the length of the Acceleration 
vector. 

The default value is 0.03. Because you are tripling the scaling 
factor, the acceleration vectors will now be three times as long.

3. Click the Color button next to the Acceleration vector in the 
Vector Settings dialog.

The Color dialog appears, as shown in Figure 2-13. 

Figure 2-13

Color Dialog

4. Choose a bright red color and click OK to close the Color dialog.

The acceleration vector will now be displayed in red.

5. Click OK to close the Vector Settings dialog.

6. Click the Run button in the Tape Player Control.
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As the simulation runs, note that the acceleration vector attached to 
the connecting rod switches sides (because the acceleration 
switches direction halfway through the full cycle), as shown in 
Figure 2-14.

Figure 2-14

Acceleration Vector on Connecting 
Rod

7. Click the Stop button, then reset the simulation by clicking the 
Reset button.

The piston assembly returns to the initial position.

2.7 Fine-tuning the Simulation

Up to this point, the piston mechanism has been driven by a motor 
constraint attached to the crankshaft. In a more realistic simulation of an 
internal combustion engine, a throttle force generated by a gas explosion 
in a cylinder chamber would push the piston down to torque the 
crankshaft. In this last step, you will fine-tune the model to simulate this 
more realistic scenario.

Convert the Motor

First, you will convert the motor to a revolute joint.

1. Double-click the revolute motor, “constraint[10]” in the Object 
List. 

Acceleration
Vector
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The constraint’s properties are displayed in the Properties window.

2. Click the Constraint tab.

3. Select Revolute Joint from the list of available constraints, as 
shown in Figure 2-15.

The motor is replaced by a revolute joint.

Figure 2-15

Constraint Settings Dialog

Attach a Force Load

Next, you will attach a force load to the top of the piston to simulate the 
force generated by a gas explosion in a cylinder chamber.

1. Click the Toggle Wireframe button in the View toolbar.

The drawing window changes to a shaded rendering, which will 
make it easier to complete the next steps. 

2. Click the Rotate Around tool in the View toolbar or press “T” on 
the keyboard, so that you can see the top of the piston head.

Your view should be similar to Figure 2-16. 
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Figure 2-16

Top of the Piston Head

3.  Click the Force tool in the Sketch toolbar.

4. Click the mouse pointer at the top of the Piston, near the center.

The precise location of the attachment is not important for this 
exercise.

5. Double-click the force icon in the drawing window or in the 
Object List. 

The force’s properties appear in the Properties window.

6. If necessary, click the Force tab, then enter “–10” in the z-field 
to apply a 10 Newton force downward, as shown in Figure 2-17.

The force’s Coord attachment dictates this orientation setting.

Figure 2-17

Properties Window 
(Force Page)
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7. Choose Go Home in the View menu.

Your original view of the piston assembly (which provides a better 
view of the motion) is restored. 

8.  Click the Run button in the Tape Player Control.

As the simulation runs, the piston behaves like a pendulum, because 
the pressure is applied constantly, which isn’t a realistic scenario.

9. Click the Stop button, then reset the simulation by clicking the 
Reset button.

The piston assembly returns to the initial position.

Modify the Force to Simulate Realistic Throttle

As a final step, you will modify the force to simulate realistic throttle by 
using a formula to control when the force is applied.

1. Double-click the force icon in the drawing window or in the 
Object List. 

The force’s properties appear in the Properties window.

2. Click the Active tab.

3. Click the “Active when the following formula is greater than 0:” 
radio button, then enter the following formula, as shown in 
Figure 2-18:

and(body[7].v.z <= 0, |body[2].w| < 62)

The formula applies the explosive force only when the piston is 
coming down, and cuts off the push to limit the motor to 
approximately 600 rpm (62 rad/sec).

NOTE: All formula expressions are interpreted in SI unit system, so you 
must enter 62 rad/sec, the SI equivalent of 600 rpm.
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Figure 2-18

Properties Window 
(Active Page) for Force

4. Run the simulation.

The piston behaves as expected under the realistic throttle force. 

Verify the Result

You can verify that your model is accurate by creating a meter to 
measure angular velocity of the crankshaft, and setting the angular 
velocity unit system to RPM. The angular velocity of the crankshaft 
should settle at around 600 rpm.

1. Select “Crank_par_1”, the left half of the crank, in the Object 
List.

2. Choose Angular Velocity from the Measure menu.

A new meter window appears, titled “Angular Velocity of 
Crank_par_1”.

3. Choose Numbers & Units in the World menu.

The Numbers & Units dialog appears as shown in Figure 2-19.
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Figure 2-19

Numbers & Units Dialog

4. Choose “rpm” in the Rot. Vel. pull-down list.

5. Click OK to close the Numbers & Units dialog.

6. Run the simulation.

As the simulation runs, the angular velocity, |W|, grows to 
approximately 600 rpm, then levels off, as shown in Figure 2-20.

Figure 2-20

Angular Velocity Meter

Choose
“rpm”
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E X E R C I S E  3

Exploring CAD Integration and Associativity

This exercise illustrates how you can add motion to a model that has been 
created in a CAD software package. 

You can create CAD assemblies in such a way that they map into 
Working Model 3D very cleanly. When you design assemblies with 
“motion in mind,” they can be imported easily, and their motion can be 
simulated immediately.

In this exercise, you will add motion to an assembly that has been fitted 
together with no regard to motion. Although you will have to clean up a 
few constraints in the imported CAD model, Working Model 3D makes 
it easy to simulate the motion of the assembly.
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To complete this exercise, you must have one of the following 
combinations of software installed on your computer:

• Mechanical Desktop 2.01 and Working Model for Mechanical 
Desktop

• Solid Edge 3.02 and Working Model for Solid Edge

• SolidWorks 97Plus3 and Working Model for SolidWorks

If you have not installed one of these CAD integration programs, please 
refer to Getting Started with Working Model 3D for installation 
instructions.

You can follow the steps in this exercise using any of the supported CAD 
packages — Mechanical Desktop, Solid Edge, or SolidWorks. In most 
cases, the steps are the same for all three CAD packages. Where they 
differ, follow the one path for your CAD software: 

• Path A — Mechanical Desktop only

• Path B — Solid Edge only

• Path C — SolidWorks only

3.1 Exporting a CAD Model 

A — Mechanical Desktop only 

A1. Launch the Mechanical Desktop program.

Note that a Motion menu appears in the Mechanical Desktop 
menubar, as shown in Figure 3-1.

1. Mechanical Desktop is a registered trademark of Autodesk, Inc.
2. Solid Edge is a registered trademark of Intergraph Corporation.
3. SolidWorks is a registered trademark of SolidWorks Corporation.
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Figure 3-1

Motion Menu in Mechanical 
Desktop

A WM3D toolbar also appears in the Mechanical Desktop window, 
as shown in Figure 3-2.

Figure 3-2

WM3D Toolbar 
in Mechanical Desktop

A2. Open the file “Piston.dwg” located in your “Program 
Files\Working Model 3D\Tutorials\Exercise 3\Mechanical 
Desktop” directory. 

The CAD model of the piston assembly is displayed as shown in 
Figure 3-3.

Working Model 

Help

for Mechanical Desktop
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Figure 3-3

Mechanical Desktop CAD Model 
of Piston Assembly

A3. Choose Simulate Motion in the Motion menu, or click the 
Gyroscope button in the WM3D toolbar.

Working Model for Mechanical Desktop maps the assembly 
components and constraints into Working Model 3D bodies and 
joints, and creates a new, linked model named “Piston.wm3” in the 
same directory. As Working Model 3D translates the geometry, the 
progress is displayed in the Preparing Simulation dialog.

When the process is done, the Working Model 3D program opens 
and displays the CAD Associativity dialog, listing the Working 
Model 3D objects that are associated with objects in the Mechanical 
Desktop model as shown in Figure 3-4.
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Figure 3-4

CAD Associativity Dialog

 

A4. Click OK to close the CAD Associativity dialog.

The linked model appears in the Working Model 3D window as 
shown in Figure 3-5.

Figure 3-5

Linked Mechanical Desktop Model 
Opened in Working Model 3D 
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B —   Solid Edge only 

B1. Launch the Solid Edge:Assembly program.

Note that the WM3D toolbar appears at the left edge of the Solid 
Edge window, as shown in Figure 3-6.

Figure 3-6

WM3D Toolbar in Solid Edge

B2. Open the file “Piston.asm” located in your “Program 
Files\Working Model 3D\Tutorials\Exercise 3\Solid Edge” 
directory. 

The CAD model of the piston assembly is displayed as shown in 
Figure 3-7.

Working Model 

Help

for Solid Edge
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Figure 3-7

Solid Edge CAD Model 
of Piston Assembly

B3. Click the Gyroscope button in the WM3D toolbar.

The Working Model for Solid Edge dialog appears, as shown in 
Figure 3-8.

Figure 3-8

Working Model for Solid Edge 
Dialog

B4. Click the Build Model button.

Working Model for Solid Edge maps the assembly components and 
constraints into Working Model 3D bodies and joints, and creates a 
new, linked model named “Piston.wm3” in the same directory. As 
Working Model 3D translates the geometry, the progress is 
displayed in the Working Model for Solid Edge dialog.
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When the process is done, the Working Model 3D program opens 
and displays the CAD Associativity dialog, listing the Working 
Model 3D objects that are associated with objects in the Solid Edge 
model as shown in Figure 3-9.

Figure 3-9

CAD Associativity Dialog

 

B5. Click OK to close the CAD Associativity dialog.

The linked model appears in the Working Model 3D window as 
shown in Figure 3-10.
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Figure 3-10

Linked Solid Edge Model Opened 
in Working Model 3D 

C — SolidWorks only 

C1. Launch the SolidWorks 97Plus program.

C2. Open the file “Piston.sldasm” located in your “Program 
Files\Working Model 3D\Tutorials\Exercise 3\SolidWorks” 
directory. 

The CAD model of the piston assembly is displayed as shown in 
Figure 3-11.
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Figure 3-11

SolidWorks CAD Model 
of Piston Assembly

Note that a Motion menu appears in the SolidWorks menubar, as 
shown in Figure 3-12.

Figure 3-12

Motion Menu in SolidWorks

C3. Choose Simulate Motion in the Motion menu.

Working Model for SolidWorks maps the assembly components and 
constraints into Working Model 3D bodies and joints, and creates a 
new, linked model named “Piston.wm3” in the same directory. As 
Working Model 3D translates the geometry, the progress is 
displayed in the Preparing Simulation dialog. 

When the process is done, the Working Model 3D program opens 
and displays the CAD Associativity dialog, listing the Working 
Model 3D objects that are associated with objects in the SolidWorks 
model as shown in Figure 3-13.
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Figure 3-13

CAD Associativity Dialog

 

C4. Click OK to close the CAD Associativity dialog.

The linked model appears in the Working Model 3D window as 
shown in Figure 3-14.

Figure 3-14

Linked SolidWorks Model Opened 
in Working Model 3D 
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3.2 Anchoring the Assembly

Based on the constraints and geometry in the CAD model, Working 
Model 3D may anchor some parts to the background when it creates the 
linked model. The first step in simulating the motion of the piston 
assembly is to make sure that it is properly anchored. 

• If no bodies in the assembly are anchored, the piston is floating in 
space and gravity will cause it to fall when you run the simulation. 

• If too many bodies are anchored, the piston won’t be able to move 
appropriately when you run the simulation.

A —   Mechanical Desktop only 

When Working Model 3D imports the piston assembly from Mechanical 
Desktop, it doesn’t anchor any bodies.

In order for the piston to move properly, you must anchor the body 
named “ANCHOR_1/COMP1_1” to the background. 

A1. Double-click “ANCHOR_1/COMP1_1” in the Object List.

The Properties window for “ANCHOR_1/COMP1_1” appears.

A2. If necessary, click the Pos tab in the Properties window, then 
click the Anchored box to put a checkmark in it, as shown in 
Figure 3-15.
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Figure 3-15

Properties Window 
(Position Page) for the Anchor

B — Solid Edge only 

When Working Model 3D imports the piston assembly from Solid Edge, 
it anchors two bodies: the connecting rod, named “CONNECTING 
ROD.PAR:1”, and the body named “ANCHOR.PAR:1”.

In order for the piston to move properly, you must remove the anchor 
from the connecting rod. Only the body named “ANCHOR.PAR:1” 
should be anchored to the background. 

B1. Look at the Object List and note any bodies that have an anchor 
symbol attached to their icons.

Two bodies in the linked model, “ANCHOR.PAR:1” and 
“CONNECTING ROD.PAR:1”, were anchored by Working Model 
3D. 

B2. Double-click “CONNECTING ROD.PAR:1”.

The Properties window for “CONNECTING ROD.PAR:1” appears.

B3. If necessary, click the Pos tab in the Properties window, then 
click the Anchored box to remove the checkmark as shown in 
Figure 3-16.

Check this box
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Figure 3-16

Properties Window 
(Position Page) for Connecting 
Rod

B4. Click the Toggle Wireframe button in the View toolbar.

The drawing window changes to a shaded rendering, which will 
make it easier for you to see the motion of the assembly parts as the 
simulation runs. 

C —   SolidWorks only 

When Working Model 3D imports the piston assembly from 
SolidWorks, it anchors the bodies appropriately. No modifications are 
necessary.

 All CAD Packages

1. Click the Run button in Working Model 3D’s Tape Player 
Control, and let the simulation run for about 100 frames.

Working Model 3D begins to simulate the motion of the model. The 
piston assembly balances at first, then the piston head falls under the 
effect of gravity. Since the piston is almost in equilibrium, you will 
not see any movement at first. 

Remove this checkmark
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The geometry of the assembly causes the piston head to swing like a 
pendulum around the crank pin, which is held in place by the 
anchor, as shown in Figure 3-17. 

Figure 3-17

Piston Head Swinging Around the 
Crank Pin Like a Pendulum 

Since this is the first time the simulation is being run, Working 
Model 3D calculates the dynamics and stores the data. 

2. Repeat the simulation by clicking the Stop button, then the 
Reset button, and then the Run button again.

The animation is faster this time because the history has already 
been calculated.

3.3 Adding a Motor

Currently, the piston assembly is moving only in response to the effects 
of gravity. In this step, you will change the joint between the anchor and 
left side of the crank to a motor to simulate the force that drives the 
motion of the piston. 
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A — Mechanical Desktop only 

A1. Select “ANCHOR_1/COMP1_1” in the Object List.

The Connections List displays a list of the objects connected to this 
body.

A2. Double-click “constraint[65]”, the revolute joint that connects 
“ANCHOR_1/COMP1_1” to “CRANK_1/COMP1_1”.

The Properties window for “constraint [65]” appears.

A3. If necessary, click the Constraint tab in the Properties window. 
Then, select Revolute Motor for the list of available joint types, 
as shown in Figure 3-18.

The revolute joint is changed into a revolute motor. 

Figure 3-18

Properties Window 
(Constraint Page) for Revolute 
Motor

A4. Click the Motor tab in the Properties window. Then, choose 
Angular Velocity from the list of Motor Types.

A5. Enter 500 as the value for angular velocity of this Revolute 
Motor, as shown in Figure 3-19.

You can close the Properties window now.
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Figure 3-19

Properties WIndow 
(Motor Page)

B — Solid Edge only 

B1. Select “ANCHOR.PAR:1” in the Object List.

The Connections List displays a list of the objects connected to this 
body.

B2. Double-click “constraint[63]”, the revolute joint that connects 
“ANCHOR.PAR:1” to “CRANK.PAR:1”.

The Properties window for “constraint [63]” appears.

B3. If necessary, click the Constraint tab in the Properties window. 
Then, select Revolute Motor for the list of available joint types, 
as shown in Figure 3-20.

The revolute joint is changed into a revolute motor. 
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Figure 3-20

Properties Window 
(Constraint Page) for Revolute 
Motor

B4. Click the Motor tab in the Properties window. Then, choose 
Angular Velocity from the list of Motor Types.

B5. Enter 500 as the value for angular velocity of this Revolute 
Motor, as shown in Figure 3-21.

You can close the Properties window now.

Figure 3-21

Properties Window 
(Motor Page)

C — SolidWorks only 

C1. Select “ANCHOR-1” in the Object List.

The Connections List displays a list of the objects connected to this 
body.

C2. Double-click “Concentric1”, the revolute joint that connects 
“ANCHOR-1” to “CRANK-1”.
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The Properties window for “Concentric1” appears.

C3. If necessary, click the Constraint tab in the Properties window. 
Then, select Revolute Motor for the list of available joint types, 
as shown in Figure 3-22.

The revolute joint is changed into a revolute motor. 

Figure 3-22

Properties Window 
(Constraint Page) for Revolute 
Motor

C4. Click the Motor tab in the Properties window. Then, choose 
Angular Velocity from the list of Motor Types.

C5. Enter 500 as the value for angular velocity of this Revolute 
Motor, as shown in Figure 3-23.

You can close the Properties window now.

Figure 3-23

Properties WIndow 
(Motor Page)
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 All CAD Packages

1. Click the Run button in Working Model 3D’s Tape Player 
Control.

The piston assembly rotates all the way around the crank pin, as 
shown in Figure 3-24. It no longer swings like a pendulum, because 
the motor provides the driving force to keep the piston rotating. 

Figure 3-24

Piston Head Rotating All the Way 
Around the Crank Pin 

2. Click the Stop button.

3.4 Adjusting the Joints 

When Working Model 3D exports the CAD model, it creates joints 
between parts of the assembly. The types of joints created depends on the 
constraints and geometry of the CAD model. 

If the joints that Working Model 3D creates are not given the appropriate 
degrees of freedom, the parts cannot move appropriately when you run 
the simulation. To correct this problem, you should verify and adjust the 
joints between the parts of the assembly as necessary to correctly specify 
the motion desired.

A —   Mechanical Desktop only 
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Currently, the connecting rod and the crank assembly move together like 
a single rigid body. In this step, you will adjust the joints to give each the 
appropriate degrees of freedom.

Adjust the Joints on the Connecting Rod

The connecting rod has been given too many constraints by Working 
Model 3D. In this step, you will remove two rigid joints that are currently 
preventing the true motion between the connecting rod and other 
assembly parts from occurring.

A1. Select “CON_ROD_1/COMP1_1” in the Object List.

The Connections List displays the constraints and Coords attached 
to the connecting rod.

A2. Select “constraint[69]”, the first rigid joint, in the Connections 
List.

The Connections list displays the bodies and Coords attached to the 
rigid joint.

A3. Hold down the Control key and click on “coord[29]” and 
“coord[31]”, the two Coords attached to the rigid joint, in the 
Connections list.

The rigid joint, “constraint[69]”, as well as the two Coords, 
“coord[29]” and “coord[31]” should be selected when you are 
done.

A4. Press the Delete key.

The rigid joint and the two Coords are removed from the model.

A5. Repeat steps A1 thru A4 to remove “constraint[73]”, the other 
rigid joint, and “coord[37]” and “coord[39]” from the connecting 
rod.

Adjust the Joints on the Crank Pin

The crank pin has been given the right number of constraints by Working 
Model 3D, but the joints have been given too much freedom. In this step, 
you will change two revolute joint on slots (which can slide along an 
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axis) into standard revolute joints (which cannot slide) to eliminate a 
degree of freedom. This change models the true motion allowed between 
the crank pin and other assembly parts.

A1. Select “CRANKPIN_1/COMP1_1” in the Object List.

The Connections list displays the constraints and Coords attached 
to the crank pin.

A2. Double-click “constraint[71]”, the first revolute joint on slot, in 
the Connections List.

The Properties window for “constraint [71]” appears.

A3. If necessary, click the Constraint tab in the Properties window. 
Then, select Revolute Joint for the list of available joint types, 
as shown in Figure 3-26.

The revolute joint on slot is changed into a revolute joint. 

An alternative way to change a revolute joint on slot into a standard 
revolute joint is to choose “No axes” from the Slide Along section of 
the Constraint page.

Figure 3-25

Properties Window 
(Constraint Page) for Revolute 
Joint

A4. Repeat steps A1 thru A3 to change “constraint[75]”, the other 
revolute joint on slot on the crank pin, into a revolute joint.
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B — Solid Edge only 

Currently, all of the parts in the piston assembly move together like a 
single rigid body. In this step, you will adjust the joints to give each the 
appropriate degrees of freedom.

Adjust the Joints on the Connecting Rod

The connecting rod has been given too many constraints by Working 
Model 3D. In this step, you will remove two rigid joints that are currently 
preventing the true motion between the connecting rod and other 
assembly parts from occurring.

B1. Select “CONNECTING ROD.PAR:1” in the Object List.

The Connections List displays the constraints and Coords attached 
to the connecting rod.

B2. Select “constraint[67]”, the first rigid joint, in the Connections 
List.

The Connections list displays the bodies and Coords attached to the 
rigid joint.

B3. Hold down the Control key and click on “coord[29]” and 
“coord[31]”, the two Coords attached to the rigid joint, in the 
Connections list.

The rigid joint, “constraint[67]”, as well as the two Coords, 
“coord[29]” and “coord[31]” should be selected when you are 
done.

B4. Press the Delete key.

The rigid joint and the two Coords are removed from the model.

B5. Repeat steps B1 thru B4 to remove “constraint[79]”, the other 
rigid joint, and “coord[59]” and “coord[61]” from the connecting 
rod.
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Adjust the Joints on the Crank Pin

The crank pin has been given the right number of constraints by Working 
Model 3D, but the joints have been given too much freedom. In this step, 
you will change two revolute joint on slots (which can slide along an 
axis) into standard revolute joints (which cannot slide) to eliminate a 
degree of freedom. This change models the true motion allowed between 
the crank pin and other assembly parts.

B1. Select “CRANK PIN.PAR:1” in the Object List.

The Connections list displays the constraints and Coords attached 
to the crank pin.

B2. Double-click “constraint[69]”, the first revolute joint on slot, in 
the Connections List.

The Properties window for “constraint [69]” appears.

B3. If necessary, click the Constraint tab in the Properties window. 
Then, select Revolute Joint for the list of available joint types, 
as shown in Figure 3-26.

The revolute joint on slot is changed into a revolute joint. 

An alternative way to change a revolute joint on slot into a standard 
revolute joint is to choose “No axes” from the Slide Along section of 
the Constraint page.

Figure 3-26

Properties Window 
(Constraint Page) for Revolute 
Joint

B4. Repeat steps B1 thru B3 to change “constraint[71]”, the other 
revolute joint on slot on the crank pin, into a revolute joint.
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C — SolidWorks only 

Currently, all of the parts in the piston assembly move together like a 
single rigid body. In this step, you will adjust the joints to give each the 
appropriate degrees of freedom.

Adjust the Joints on the Connecting Rod

The connecting rod has been given too many constraints by Working 
Model 3D. In this step, you will remove one rigid joint that is currently 
preventing the true motion between the connecting rod and other 
assembly parts from occurring.

C1. Select “CONNECTING ROD-1” in the Object List.

The Connections List displays the constraints and Coords attached 
to the connecting rod.

C2. Select “Distance3”, the rigid joint, in the Connections List.

The Connections list displays the bodies and Coords attached to the 
rigid joint.

C3. Hold down the Control key and click on “Distance3 on /Crank-1” 
and “Distance3 on /CONNECTING ROD-1”, the two Coords 
attached to the rigid joint, in the Connections list.

The rigid joint, “Distance3”, as well as the two Coords, “Distance3 
on /Crank-1” and “Distance3 on /CONNECTING ROD-1” should 
be selected when you are done.

C4. Press the Delete key.

The rigid joint and the two Coords are removed from the model.

Adjust the Joints on the Crank Pin

The crank pin has been given the right number of constraints by Working 
Model 3D, but the joints have been given too much freedom. In this step, 
you will change one revolute joint on slot (which can slide along an axis) 



3-26 Exercise 3—Exploring CAD Integration and Associativity

into a standard revolute joint (which cannot slide) to eliminate a degree 
of freedom. This change models the true motion allowed between the 
crank pin and other assembly parts.

C1. Select “CRANK PIN-1” in the Object List.

The Connections list displays the constraints and Coords attached 
to the crank pin.

C2. Double-click “Concentric3”, the revolute joint on slot, in the 
Connections List.

The Properties window for “Concentric3” appears.

C3. If necessary, click the Constraint tab in the Properties window. 
Then, select Revolute Joint for the list of available joint types, 
as shown in Figure 3-27.

The revolute joint on slot is changed into a revolute joint. 

An alternative way to change a revolute joint on slot into a standard 
revolute joint is to choose “No axes” from the Slide Along section of 
the Constraint page.

Figure 3-27

Properties Window 
(Constraint Page) for Revolute 
Joint

All CAD Packages

1. Click the Run button in Working Model 3D’s Tape Player 
Control.
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The crank is driven around the crank pin by the motor, and the 
connecting rod swings freely, as shown in Figure 3-28.

Figure 3-28

Connecting Rod Swinging Freely 

2. Click the Stop button.

The only remaining problem is that the piston head flops around, 
because its motion is not adequately constrained.

Constrain the Motion of the Piston Head

In this step, you will add a new constraint that limits the motion of the 
piston head, so that it can only move vertically.

 All CAD Packages

1. Reset the simulation by clicking the Reset button.

The piston assembly returns to its starting position.

2. Click the Rotate Around tool in the View toolbar or press “T” on 
the keyboard so that you can see the top of the piston head.

Your view should be similar to Figure 3-29. 
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Figure 3-29

Top of the Piston Head

3. Click the Coord tool in the Sketch toolbar, then place a Coord on 
the top surface of the piston head, near the center.

The z-axis of the Coord should point upward.

4. Make sure the Coord that you just created is selected, then click 
the Join/Create Constraint button in the Edit toolbar.

The Create Constraint window appears.

5. Select Rigid Joint on Slot from the list of available constraint 
types, as shown in Figure 3-30, then click Create.

A rigid joint on slot appears on top of the piston head. This 
constraint connects the piston head to the background and allows 
the piston head to move only in the vertical (z-axis) direction. 
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Figure 3-30

Create Constraint Window

 

6. Choose Go Home in the View menu.

Your original view of the piston assembly (which provides a better 
view of the motion) is restored. 

7. Click the Run button in Working Model 3D’s Tape Player 
Control.

The piston head is pushed up and pulled down by the connecting rod 
as the crank rotates about the crank pin, as shown in Figure 3-31.

Figure 3-31

Piston Head Pushed Up and Pulled 
Down by the Connecting Rod

8. Click the Stop button.

Your model of the motion of the piston assembly is now complete!
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3.5 Using CAD Associativity

You’ve put a lot of work into adapting the CAD model to accurately 
simulate the motion of the piston assembly. What happens if the CAD 
model changes? 

When you re-export the CAD model, any changes to it are automatically 
incorporated into your simulation of the motion. All of the changes and 
enhancements that you have already made in the simulation are left 
unchanged. 

Change the Connecting Rod Length and Re-export 
the CAD Model

In this step, you will re-export the model to Working Model 3D. When 
you return to Working Model 3D, the changes you made will 
automatically be incorporated into your simulation of the motion.

A —   Mechanical Desktop only 

A1. Reopen the “Piston” model in your CAD software.

A2. Change the length of the Connecting Rod part from 15 cm to 25 
cm.

If needed, refer to your CAD software User’s Manual or online help 
for instructions on how to change the length of the connecting rod 
part.

A3. Choose Simulate Motion in the Motion menu.

Working Model for Mechanical Desktop re-exports the piston 
assembly components and constraints. When the process is done, the 
Working Model 3D program reopens the linked model, as shown in 
Figure 3-32.
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Figure 3-32

Changes in the Mechanical 
Desktop CAD Model Reflected in 
Working Model 3D 

Your changes to the CAD model are reflected in Working Model 3D. 
The length of the connecting rod has been changed.

B —   Solid Edge only 

B1. Reopen the “Piston” model in your CAD software.

B2. Change the length of the Connecting Rod part from 150 mm to 
250 mm.

If needed, refer to your CAD software User’s Manual or online help 
for instructions on how to change the length of the connecting rod 
part.

B3. Save your changes to the Connecting Rod part.

Solid Edge requires you to save your changes before you can re-
export the model to Working Model 3D.

B4. Click the Gyroscope button in the WM3D toolbar.
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The Working Model for Solid Edge dialog appears, as shown in 
Figure 3-33.

Figure 3-33

Working Model for Solid Edge 
Dialog

B5. Click the Build Model button.

Working Model for Solid Edge re-exports the piston assembly 
components and constraints. When the process is done, the Working 
Model 3D program reopens the linked model, as shown in Figure 3-
34.

Figure 3-34

Changes in the Solid Edge CAD 
Model Reflected in Working Model 
3D



3.5 Using CAD Associativity 3-33

Your changes to the CAD model are reflected in Working Model 3D. 
The length of the connecting rod has been changed.

C — SolidWorks only 

C1. Reopen the “Piston” model in your CAD software.

C2. Change the length of the Connecting Rod part from 150 mm to 
250 mm.

If needed, refer to your CAD software User’s Manual or online help 
for instructions on how to change the length of the connecting rod 
part.

C3. Choose Simulate Motion in the Motion menu.

Working Model for SolidWorks re-exports the piston assembly 
components and constraints. When the process is done, the Working 
Model 3D program reopens the linked model, as shown in Figure 3-
35.
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Figure 3-35

Changes in the SolidWorks CAD 
Model Reflected in Working Model 
3D 

Your changes to the CAD model are reflected in Working Model 3D. 
The length of the connecting rod has been changed.

 All CAD Packages

1. Click the Run button in Working Model 3D’s Tape Player 
Control.

Your simulation of the motion of the piston assembly runs with no 
problems.

2. Click the Stop button.

Working Model 3D preserves and protects your enhancements to the 
simulation model, while giving you the flexibility to change the 
underlying geometry of the CAD model as needed.
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Creating a Piston Model

The goals of this exercise are to show you how to create constraints and 
assemble bodies in Working Model 3D and how to take data from the 
simulation through meters.  The target model is a simple piston engine 
model consisting of a crankshaft, a connecting rod, and a piston.  The 
engine has a skewed crankshaft (i.e., the rotation axis is not orthogonal 
to the translation axis of the piston); therefore, the model can only be 
illustrated in a three-dimensional simulator.

In a conventional internal combustion engine, a gas explosion in the 
chamber pushes down the piston to drive the crankshaft. For simplicity, 
however, this tutorial exercise calls for a mechanism that is driven by 
rotating a crankshaft with a motor; you can think of the model as a 
rudimentary compressor, or a piston engine being started by a crank 
motor.
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4.1 Setting Up the Workspace

You will first set up the unit system in the Working Model 3D document 
in order to accommodate small mechanisms such as a piston engine.  The 
default unit system employs the SI unit system (where distance is 
measured in meters).  You will change the distance unit to millimeters, 
while leaving all other units (such as time and mass) intact.

Setting Up the Units

To change the unit system:

1. Choose the Numbers & Units in the World menu.

The Numbers & Units dialog appears (Figure 4-1). By default, the 
SI (degrees) unit system is chosen.

Figure 4-1

Numbers & Units Dialog

2. Set the distance units to millimeters.

3. Click the OK button to close the dialog.

All distance measurements in this document will now be in millimeters.
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Setting Up the Edit Grid

You will modify the size of the Edit Grid and zoom rate of the document 
so that they are appropriate for the dimensions of the components you 
will create.

To change the Edit Grid size:

1. Choose Show Grid in the Grid menu.

The Edit Grid appears.

2. Choose Grid Settings in the Grid menu.

The Grid Settings dialog appears (Figure 4-2).

Figure 4-2

Grid Settings Dialog

3. Type 200 into Grid Extents and 10 into Grid Snap edit boxes.

4. Click OK to close the dialog.

Note that the units in the dialog are based on millimeters.  Working 
Model 3D automatically scales the document window to 
accommodate the smaller Edit Grid.

5. Click the Zoom In/Out tool on the View toolbar.
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The Zoom tool allows you to zoom into the document with a 
particular focus.  The first mouse click becomes your focus for 
zooming.

6. Click the global coordinate origin, hold down the mouse button, 
and drag the mouse downward to zoom in.  Note that if you 
move the mouse upward, you can zoom out.

7. Release the mouse button when the Edit Grid fills a reasonable 
portion of your document window.  You can repeat the previous 
step to zoom in further.

See Figure 4-3 for an example.

Figure 4-3

Document Zoomed In

If your Edit Grid does not appear to be quite centered, use the Pan tool to 
shift the view laterally.

4.2 Creating the Crankshaft

In this exercise, the crankshaft is simplified as a single disk, and you will 
later attach a connecting rod from the piston to this disk so that the phase 
will be offset by 180°.

Use the Zoom In/Out tool
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You will specify the geometry and position of the body using the 
Properties window.

1. Click the Cylinder tool on the Sketch toolbar.

2. Click once on the Edit Grid, then press the Enter key on your 
keyboard.

A small cylinder appears where you clicked.

3. Double-click the cylinder in the document window or the Object 
Manager list.

The Properties window appears.

4. Click the Position (Pos) tab.

The Properties window displays the Position page, as shown in 
Figure 4-4.

Figure 4-4

Properties Window 
(Position Page) for the Cylinder

5.  Enter the position as (x, y, z) = (0, 0, 0),

6. Click the Geometry tab.

The Properties window displays the Geometry page, as shown in 
Figure 4-5.
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Figure 4-5

Properties Window (Geometry 
Page) for the Cylinder

7. Enter radius = 25, height = 10 in the dialog.

Note that all the numbers are interpreted in millimeters.  You can 
use the tab key to move from one field to another.

8. Close the Properties window.

The cylinder is accordingly sized and positioned on the screen (see 
Figure 4-6).

Figure 4-6

Crankshaft Sized and Positioned

Currently, the crankshaft is oriented so that it lies flat on the xy plane.  
You will reorient the shaft so that it is slightly skewed.

9. Double-click the crankshaft cylinder in the document window or 
the Object List.

The Properties window reappears.
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10. Click the Position (Pos) tab.

The Properties window displays the Position page, as shown in 
Figure 4-7.

Figure 4-7

Properties Window 
(Position Page) for the Cylinder

11. Enter the orientation of the cylinder as (Rx, Ry, Rz) = (0, 35, 0).

The crankshaft is reoriented as soon as you tab out of the Ry field. 
You do not need to close the Properties window to have the changes 
take effect.

Assigning a Name to the Crankshaft

As you create bodies in a document, Working Model 3D automatically 
assigns a variable name (such as body[3], body[4]...) to each of them.  
Although not necessary for this exercise, you will name each body so that 
you can easily identify them later.

1. Click the Appearance tab at the top of the Properties window.

The Appearance page appears, as shown in Figure 4-8.

Enter orientation here.
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Figure 4-8

Properties Window 
(Appearance Page) for Cylinder

2. In the Name field of the window, type crankshaft in the edit box, 
then press the Enter key on your keyboard.

To see how the custom name helps you in identifying bodies, simply 
“hover” the mouse over the crankshaft cylinder. Note that the status bar 
at the bottom of the Working Model 3D window identifies the body with 
the variable name (body[n]) as well as the custom name you have just 
assigned. See Figure 4-9 for an example. 

Figure 4-9

Status Bar Identifying Object

 

The custom name for this body also appears in the Object List.

4.3 Attaching a Motor to the Crankshaft

You will now fix the crankshaft to the background.

1. Select the crankshaft, if it is not already selected.

2. Click the Join/Create Constraint button in the Edit toolbar.

The Create Constraint window appears (Figure 4-10).

Type the name (crankshaft) here.

Status Bar Identification
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Figure 4-10

Create Constraint Window

3. Choose Revolute Motor in the list of constraint types.

The Create Constraint window is best understood when you read the first 
few lines of the window as a complete sentence.  In our case, the dialog 
reads:

“Create a motor from a new coord on crankshaft to a new coord on 
the background.”

Therefore, the dialog is set up to create a motor between the crankshaft 
and the background.

Meanwhile, the bottom half of the window provides the only option that 
reads:

“Join crankshaft in place (at center of crankshaft)”

The option indicates that the motor will be attached to the crankshaft at 
its center and that the crankshaft will not move—the body will be joined 
“in place”.

Working Model 3D provides a range of options depending on the 
constraint type and objects you select before creating constraints.  Please 
refer to the Working Model 3D User’s Manual for more information.

4. Click the Create button in the window.

The Create Constraint window closes.

Constraint Type 
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Note that a motor icon appears at the center of the cylinder.  Also, notice 
that:

• The motor icon has a green cube around it (when it is selected) with 
an axis that shows the plane in which the motor allows rotation.

• Working Model 3D created a red disk-shaped object called a Coord. 
The model actually has two Coords at the same global position, 
where one is attached to the crankshaft and the other to the 
background (Figure 4-11 displays only one of them, because the two 
Coords for the motor are overlapped at this point).

You may wish to zoom in further to gain a better view of these symbols.

What is a Coord? Coords are basic objects to construct constraints in Working Model 3D.  
Physically, a Coord is a point element with a coordinate system attached.  
Therefore, a Coord has position and orientation.

To visualize a Coord, simply click the red circle around the motor icon.  
Notice that a set of coordinate axes appear and that the red circle is a 
representation of the xy-plane of the Coord.  You may wish to use the 
Zoom tool to get a closer look.

Figure 4-11

Coord and Motor

All constraints (except for external forces and torques) in Working 
Model 3D consist of a pair of Coords, each of which are attached to a 
body or the background. In essence, a Coord serves as a medium between 
a body and the constraint, as illustrated in Figure 4-12.

Coord Symbol

Motor Icon
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Figure 4-12

Concept: Construction of a 
Constraint

For constraints such as spring dampers and separators, Coords serve as 
endpoints to define those physical constraints.  For joints, Working 
Model 3D uses the orientation of the pertinent Coords to determine the 
constraint conditions.

For example:

5. Double-click the motor icon located at the center of the 
crankshaft or in the Object List.

The Properties window appears for the motor, as shown in Figure 4-
13.

6. Click the Constraint tab in the Properties window.

Figure 4-13

Properties Window (Constraint 
Page) for Motor

As Figure 4-13 illustrates, each constraint that limits any degree of 
freedom shows you the free axis in terms of rotation and/or translation. 
In the case of this motor, the Properties window shows that the motor 
allows rotation in the z-axis. 

Body BodyConstraint

Coord Coord

Indicates the rotation axis.
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7. Click the Motor tab in the Properties window.

Figure 4-14

Properties Window (Motor Page) 
for Motor

Figure 4-14 illustrates that the angular velocity specification is expressed 
in the z-axis of Coord[3], one of the two (overlapping) Coords 
constituting the motor.

By modifying the position and the orientation of Coords, you can create 
a full range of constraints. For more information, please see the Working 
Model 3D User’s Manual.

Specifying the Motor Function

You will specify the motor’s performance characteristics through the 
Properties window.

1. On the Motor page of the Properties window, select Angular 
Velocity and type 40 in the value field, as shown in Figure 4-14.

The specification calls for a velocity-controlled motor, maintained to 
rotate at 40 degrees per second.  When you run the simulation, Working 
Model 3D will provide as much torque as necessary (in either direction) 
to maintain the specified angular velocity.

2. Click the Run button in the Tape Player Control.

Note that the crankshaft rotates counterclockwise (if seen from the 
positive z).  Also, note that the frame indicator at the bottom shows 
the current frame being calculated.

3. After several frames, click the Reset button.

Specify angular velocity here.

Specification is expressed in the
z-axis of Coord[3].



4.3 Attaching a Motor to the Crankshaft 4-13

Before proceeding to construct the rest of the model, we will modify the 
motor function so that it only generates some torque at the beginning of 
the motion, just like a starter motor would.

4. Double-click the motor icon.

The Properties window shows the motor characteristics.

5. Select Torque as Motor Type, and type the following expression 
in the Value field, as shown in Figure 4-15:

if(time < 0.3, 0.005, 0)

Figure 4-15

Specifying Motor Properties with 
Formula Language

The expression is an example of Working Model 3D Formula Language, 
and this expression is interpreted as follows:

If the elapsed time is less than 0.3 seconds, apply the torque of 0.005 
N-m; otherwise, apply no torque.

Note that Working Model 3D interprets all the variables and numbers in 
formula expressions in SI units. Even though the distance unit in the 
current unit system is set to millimeters, you must enter the formula as if 
the distance unit is meters. In this example, you want the value of the 
torque to be 5 N-mm, so you must enter 0.005 N-m, the equivalent value 
in SI units.

For more information on the formula language, please refer to the 
Working Model 3D User’s Manual.

Type the expression here.

Select Torque as the
motor specification.
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4.4 Creating the Connecting Rod

Next you will attach a connecting rod to the crankshaft.  (Before doing 
so, you may wish to zoom out so that the bulk of the Edit Grid is visible 
in your document window.)

To sketch the connecting rod:

1. Click the Box tool in the Sketch toolbar.

2. Click once on the Edit Grid, then press the Enter key on the 
keyboard.

3. Open the Properties window by double-clicking the box.

The Properties window appears.

4. Click the Position (Pos) tab.

5. Type the position as (x, y, z) = (0, 0, 30).

6. Click the Geometry tab.

7. Enter the dimensions as (Width, Length, Height) = (5, 70, 5).

The connecting rod is sized and positioned accordingly, as shown in 
Figure 4-16.

Figure 4-16

Connecting Rod

Connecting Rod
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As with the crankshaft, you will assign a custom name to this body as 
well.

8. Double-click the Connecting Rod.

The Properties window appears.

9. Click the Appearance tab.

The Properties window switches to the Appearance Page.

10. Select the text (body[5]) in the name field, and type the name 
con_rod.  Press Enter.

Again, notice how the status bar identifies the connecting rod and the 
crankshaft as you move the mouse over them.

4.5 Attaching the Connecting Rod to the 
Crankshaft

To attach the connecting rod to the crankshaft, you will specify the 
attachment point for the connecting rod on the crankshaft.

Creating Attachment Points

You will create one attachment point on the crankshaft, another 
attachment point on the connecting rod, and create a spherical joint based 
on these two attachment points. 

1. Click the Coord tool on the Sketch toolbar.

2. Click anywhere on the top surface of the crankshaft; you will 
position the Coord precisely in the later steps.

A Coord appears with a red circle and the coordinate axes.

3. Double-click the Coord.

The Properties window appears, as shown in Figure 4-17.

4. Click the Position (Pos) tab.
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Figure 4-17

Properties Window (Position Page) 
for Coord 

5. In the field labeled Position & Orientation with respect to 
crankshaft, enter position at (x, y, z) = (25, 0, 5).

This specification positions the Coord at the edge of the crankshaft.

6. Click the Coord tool on the Sketch toolbar.

7. Click anywhere on the connecting rod (you will position the 
Coord precisely in the later steps).

8. Double-click the Coord.

The Properties window shows the position of the Coord (similar to 
Figure 4-17).

9. In the field labeled Position & Orientation with respect to 
con_rod, enter position at (x, y, z) = (0, 35, 0), and orientation as 
(Rx, Ry, Rz) = (-90, 0, 0).

This specification (relative to the body) positions the Coord at the 
right end of the connecting rod. This time we are specifying the 
orientation as well as position because the Coord may have attached 
to the side surface of the connecting rod and not have the correct 
orientation.

Creating a Spherical Joint

You will attach the connecting rod to the crankshaft with a spherical 
joint.

Type the relative position here.

Indicates attachment to the crankshaft.
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1. Select the Coord on the connecting rod (if it is not already 
selected).

2. Holding down the Control key, select the Coord located at the 
perimeter of the crankshaft.

Both Coords are selected.

3. Click the Join/Create Constraint button on the Edit toolbar.

The Create Constraint window appears, as shown in Figure 4-18. 
Note that the body names appear as previously customized in the 
window, so that you can easily verify the bodies and Coords you are 
attaching are correct.

Figure 4-18

Create Constraint Window

4. Choose Spherical Joint as the constraint type.

As discussed in “4.3 Attaching a Motor to the Crankshaft”, read the first 
few lines of the window as a complete sentence: “Create a spherical joint 
from coord[7] of con_rod to coord[6] of crankshaft.” Working Model 3D 
automatically selects the remaining options depending on the objects you 
selected.

5. Click the option “Join (move con_rod to crankshaft)” (see 
Figure 4-18).

6. Click the Create button in the window.

The Create Constraint window closes. The connecting rod is moved 
to the crankshaft, and a spherical joint icon appears at the 
attachment point, as shown in Figure 4-19.



4-18 Exercise 4—Creating a Piston Model

Figure 4-19

Bodies Connected with a Spherical 
Joint

A green cube appears with three axes around the spherical joint when it 
is selected. For constraints that limit any rotational degree of freedom, 
these octagons appear to show the planes on which the rotations are 
allowed. Since a spherical joint allows all three rotational degrees of 
freedom, the joint symbol shows three axes.

4.6 Testing Your Model

When you create a simulation model, you should check from time to time 
to make sure that the model’s components are in working order.  If you 
are creating a complex model and put off testing it until the very end, 
finding a solution may be extremely difficult when your model yields 
erroneous simulation results.

So far, you have completed the following:

• Attached a crankshaft to the background with a motor at a skewed 
angle, and

• Attached a connecting rod to an edge of the crankshaft with a 
spherical joint.

To verify the result, you will run the simulation with a specific motor 
speed.  You can easily expect that the connecting rod will swing out as 
the crankshaft rotates.

The spherical joint
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To start testing, simply run the simulation.

1. Click the Run button in the Tape Player Control.

The simulation starts, while the frame indicator shows you the 
number of frames calculated. Note how the connecting rod swings 
out as the crankshaft rotates, as shown in Figure 4-20.

Figure 4-20

Connecting Rod Swung Out by the 
Crankshaft

2. After running for a dozen frames or so, click the Reset button in
the Tape Player Control.

If the model did not behave as discussed, you should review your model.  
A few hints are:

• If the motor is not rotating, you may have forgotten to specify the 
motor’s property. Review “4.3 Attaching a Motor to the 
Crankshaft”.

• If the connecting rod is falling downward, you probably have failed 
to attach it to the crankshaft. Review “4.5 Attaching the Connecting 
Rod to the Crankshaft”.

“Debugging” a large model is not always an easy task. As discussed in 
this section, you should take a moment every once in a while to verify 
your model’s assembly before proceeding.
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4.7 Creating the Piston

You will now create a piston and fix it in space with a slot joint.

1. Click the cylinder tool on the Sketch toolbar.

2. Click once on the Edit Grid, then press the Enter key on the 
keyboard.

3. Double-click the cylinder in the document window or the Object 
Manager list.

4. Click the Position (Pos) tab, then enter the position as (x, y, z) = 
(0, 0, 60).

5. Click the Geometry tab, then enter the geometry as (radius, 
height) = (20, 25).

The cylinder is accordingly sized and positioned on the screen (see 
Figure 4-21).

Figure 4-21

Piston Sized and Positioned

If the cylinder appears cut off at the top of your document window, click 
the Pan tool to shift the view.

To assign a custom name to the piston:

6. Double-click the piston to open the Properties window.
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7. Click the Appearance tab.

8. Click once in the name field, and type piston in the edit box.  
Press Enter.

You will now proceed to attach the piston to the background with a slot 
joint.

Attaching the Piston to the Background

The piston’s motion is restricted to the vertical axis.  You will attach the 
piston to the background using a rigid joint on slot.

1. Select the piston, if it is not already selected.

2. Click the Join/Create Constraint button on the Edit toolbar.

The Create Constraint dialog appears, as shown in Figure 4-22.

3. Choose “Rigid Joint on Slot” as the constraint type.

The window presents a single option: Join in place.

Figure 4-22

Create Constraint Window

Since you selected a single body without Coords, Working Model 3D 
automatically presents the only reasonable option.  The option means 
that Working Model 3D will create two Coords (one attached to the 
piston, the other attached to the background), and create a rigid joint on 
slot to connect the body to the background.  One of the Coords will be 
attached to the body at its frame origin (coordinate origin).

4. Click the Create button in the window.
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A rigid joint on slot icon appears at the center of the piston (see 
Figure 4-23). You may want to zoom in with the zoom tool to obtain 
a better view.

Figure 4-23

Rigid Joint on Slot Created

Note that the small green line segment indicates that this slot joint allows 
single degree of freedom in translation. Therefore, as it stands, the piston 
is allowed to slide “up-and-down” like we would like it to.

4.8 Attaching the Connecting Rod to the Piston

You will attach the connecting rod to the piston with a spherical joint, 
just as you attached the connecting rod to the crankshaft.

Creating an Attachment Point on the Connecting Rod

To create a pair of attachment points:

1. Use the Rotate Around tool so that you can see the free end of 
the connecting rod, as shown in Figure 4-24.

The small green line segment
indicates the translation axis.
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Figure 4-24

Attaching a Coord 
to the Connecting Rod

2. Click the Coord tool on the Sketch toolbar.

3. Click at the free end of the connecting rod.

If you attached the Coord on a side surface of the connecting rod, do 
not be alarmed; you will correct it in the next step.

4. Double-click the Coord.

The Properties window appears.

5. Click the Position (Pos) tab, and verify that the Coord is 
attached to the connecting rod (see Figure 4-25), and the 
configuration is given as (X, Y, Z) = (0, -35, 0), and (Rx, Ry, Rz) = 
(90, 0, 0). If any values are different, correct them.

Attach Coord here
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Figure 4-25

Properties for Coord Attached to 
the Connecting Rod

Creating an Attachment Point on the Piston

To connect the connecting rod with the piston, you will also create an 
attachment point on the piston.

1. Use the Rotate Around tool so that the bottom surface of the 
piston is facing you.

2. Click the Coord tool on the Sketch toolbar.

3. Click at the bottom surface of the piston, near the center.

If you attached the Coord on a side surface of the piston, do not be 
alarmed; you will correct it in the next step.

4. Double-click the Coord.

The Properties window appears.

5. Click the Position (Pos) tab, and verify that the Coord is 
attached to the piston, and the configuration is given as (X, Y, Z) 
= (0, 0, -12.5), and (Rx, Ry, Rz) = (0, 180, 0). If any values are 
different, correct them.

Creating a Spherical Joint

To put together the two Coords, each attached to the connecting rod and 
the piston:

Indicates that the Coord is attached to 
the con_rod.

Enter the configuration,

what is shown here.
 if different from



4.8 Attaching the Connecting Rod to the Piston 4-25

1. Select the Coord attached to the connecting rod.

2. Hold down the Control key, and select the Coord attached to the 
piston.

If you have trouble selecting these Coords in the document window, 
try selecting them in the Object List. 

3. Click the Join/Create Constraint button on the Edit toolbar.

The Create Constraint dialog appears (Figure 4-26).

Figure 4-26

Create Constraint Window

4. Select “Spherical Joint” as the constraint type, and click the 
option labeled “Split constraint (Don’t move anything)”.

You can assign the constraint and leave the bodies intact this way.  
You will assemble the joint in a later step.

5. Click the Create button in the window.

A line appears between the two Coords, and a split spherical joint 
icon appears in the Object List, as shown in Figure 4-27. At this 
point, the joint is assigned, but the bodies are not assembled.
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Figure 4-27

Split Spherical Joint in Object List

6. Make sure that constraint[15] is selected, then click the Join/
Create Constraint button on the Edit toolbar.

A dialog appears that offers you the choice of moving the bodies to 
satisfy the constraints or adjusting the coord location without 
moving the bodies, as shown in Figure 4-28.

Figure 4-28

Join Options Dialog

7. Click the Assemble radio button, then click the OK button.

Working Model 3D attempts to assemble the bodies using its quick 
assembly algorithm, but in this case, the relationship is too complex. 
When this occurs, Working Model 3D presents an Assembly Error 
dialog.

Split spherical joint
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When the Assembly Error dialog appears, you can choose which method 
you want to use to resolve the problem:

• Click the Retry button to attempt assembly using a dynamic 
assembly algorithm.

• Click Cancel to close the dialog, then use the Move tool to position 
the coords that you want to join closer together.

Using the Dynamic Assembly Algorithm

Follow these steps if you want Working Model to attempt to assemble the 
bodies using a slower, iterative, dynamic assembly algorithm.

1. Click the Retry button in the Assembly Error dialog.

A progress dialog appears to show the assembly is in process, as 
shown in Figure 4-29. At the same time, the bodies in the model 
undergo motion to show you the assembly process.

NOTE: If you do not see the progress dialog, you may have accidentally 
split another constraint by mistake. In that case, choose Select All in the 
Edit menu, and click the Join/Create Constraint button in the Edit toolbar. 
Working Model 3D will attempt to resolve all constraints 
simultaneously.

In the Join process, Working Model 3D is solving the configuration to 
find the converging solution to satisfy all the constraints. Bodies may 
appear to move away from their respective constraints at first, but 
Working Model 3D soon finds a converging solution that satisfies all the 
constraint conditions.
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Figure 4-29

Joining Process

After a while, the progress bar reaches the completion, and the progress 
dialog disappears. At this point the model is fully assembled, as shown 
in Figure 4-30, and you are ready to run the simulation.

Moving the Coords to Join Closer Together

Another approach to dealing with assembly errors is to use the Move tool 
to position the Coords that you want to join closer together. Follow these 
steps if you prefer to resolve the assembly problem using this method:

1. Click the Cancel button to close the Assembly Error dialog.

2. Select the Move tool on the Edit toolbar.

3. Drag the connecting rod and reposition it so that the Coord on 
its end is near the Coord on the piston.

4. Make sure that constraint[15] is selected, then click the Join/
Create Constraint button on the Edit toolbar.

5. Click the Assemble radio button, then click OK.

Working Model 3D attempts to assemble the bodies again using its 
quick assembly algorithm. If the Assembly Error dialog appears 
again, click the Retry button to use the dynamic assembly algorithm.
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Figure 4-30

Fully Assembled Piston Engine

4.9 Running the Simulation

To run the simulation:

1. Click the Run button in the Tape Player Control.

The simulation starts, showing the motion of the piston engine 
mechanism.  Note that the Tape Player Control located near the 
bottom of the application window shows the current frame number.

2. Let it run for 40 frames or so, and click the Reset button on the 
toolbar.

Use the Pan, Zoom, and Rotate Camera tools to obtain different view 
angles and repeat the simulation. Note that the simulation runs much 
faster the second time around, because Working Model 3D stores the 
simulation time history after the first calculations. The history remains in 
memory until you change the initial conditions.
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4.10 Taking Measurements

The simulation model you have just created serves as a powerful 
visualization tool to observe the general motion of your mechanism.  
Working Model 3D can take you further by allowing you to take 
numerical measurements on various aspects of your simulation.

In this exercise, you will create a meter to measure the angular velocity 
of the crankshaft cylinder as well as the forces experienced by the joint 
between the piston and the connecting rod.

To create a meter to measure the angular velocity of the crankshaft:

1. Select the crankshaft cylinder in the document window or the 
Object List.

2. Choose Angular Velocity in the Measure menu.

A meter with the title “Angular Velocity of crankshaft” appears as 
a separate window, as shown in Figure 4-31.

Figure 4-31

Angular Velocity Meter

Note that when the meter window is active, the toolbar icons for tools 
which do not apply to meters are disabled (appear grayed out).

By default, the angular velocity meter shows plots for angular velocities 
in x-, y-, and z-axes as well as the magnitude.  In this simulation, the 
crankshaft rotates with its z-axis fixed, so you are only interested in 
observing ωz, or the z-component of the angular velocity.

3. Select the meter in the Object List, then choose Properties in the 
Edit menu.
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The Properties window for the meter is displayed, as shown in 
Figure 4-32.

4. Click the Meter tab if not already selected.

Figure 4-32

Properties Window for Meter

5. Delete Wx, Wy, and |W| from the Label column.

As you remove items from the Label column, the formula is also 
deleted, as shown in Figure 4-33.

Figure 4-33

Properties Window for Meter after 
Unwanted Plots Removed

You will now create another meter to measure the forces experienced by 
the spherical joint between the piston and the connecting rod.

6. Select the spherical joint (constraint[15]) between the 
connecting rod and the piston in the Object List.

When a spherical joint is selected, it shows a green cube with short 
lines to show the allowable rotations.

7. Choose “Constraint Force on con_rod express in coord[14]” in 
the Measure menu.

Another meter window appears.
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8. Select this meter window, then click the Appearance tab in the 
Properties window.

The Appearance page is displayed, as shown in Figure 4-34.

Figure 4-34

Properties Window 
(Appearance Page) for Meter

9. Choose Digital.

The force meter switches to the digital format.

You are now ready to run the simulation to take measurements. To run 
the simulation:

10. Click the Run button in the Tape Player Control.

The simulation begins to show the model in motion and the meters 
display the data, as shown in Figure 4-35. Note that the angular 
velocity meter rescales the graph axes automatically as the data 
grows in magnitude.
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Figure 4-35

Simulation with Meters

11. Run the simulation until several rotation cycles are completed, 
and click the Reset button on the toolbar.

12. Repeat the simulation.

Note that the simulation runs faster during the playback; observe the 
“jerky” rotation of the crankshaft due to gravity.

4.11 Improving the Model

As the mechanism completes the cycle, note that the force exerted by the 
spherical joint shows a huge spike, especially when the crankshaft 
reaches the lowest point. In addition, the angular velocity of the crank 
motor (especially about the z-axis) varies rather dramatically.

To visualize the spike in the joint reaction force:

1. Select the force meter, then choose Properties in the Edit menu 
(or double-click the force meter window).

The Properties window displays the meter’s attributes.

2. Click the Appearance tab, then choose the Graph radio button.
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The digital meter changes to the graph format to show the history. 
Note the series of spikes seen in the force meter, as shown in 
Figure 4-36.

Figure 4-36

Force Meter and History

To avoid excessive wear and tear on the components, suppose you would 
like to put a simple control system on the crank motor to smooth the 
rotation.  (Although this scenario appears rather impractical in real 
situations, this exercise is merely designed to provide examples in 
Working Model 3D.)

1. Double-click the motor icon located at the center of the 
crankshaft.

The Properties window appears to show the motor specification.

2. Click the Motor tab, if it is not already selected.

3. Choose the Angular Velocity radio button, then enter the 
following expression in the Value field. 

0.2*(6.283-body[1].w.z)

A warning may appear to remind you that values in formulas must 
be expressed in SI units.

The expression “body[1].w.z” returns the angular velocity in 
radians per second (SI units), so other values in the formula must 
also be expressed in radians per second for consistency. The 
constant, 6.283 radians per second, is equivalent to 360 degrees per 
second.
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The expression implements a rudimentary proportional control system 
which monitors the angular velocity of the crankshaft (represented as 
body[1] in the formula). Note that, according to this expression, the 
motor is capable of applying torque in either direction.

4. Click the Run button in the Tape Player Control.

Note that the force curve on the spherical joint is much smoother.

5. Run the simulation until several rotation cycles are completed, 
and click the Reset button in the Tape Player Control.

You can export the meter data to a text file for further analysis by another 
application program.  For more information, please see the Working 
Model 3D User’s Manual.
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E X E R C I S E  5

Modeling a Gyroscope Top

The goals of this exercise are to show you how to create simple 
constrained bodies in Working Model 3D. 

You will create a model of a simple gyroscope top consisting of a 
flywheel and a rotation axle, fixed to the background with a spherical 
joint (thus having three rotational degrees of freedom). You will give the 
gyroscope an initial angular velocity to exhibit precession, which cannot 
be demonstrated with a static drawing or two-dimensional model.
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5.1 Setting Up the Workspace

In this exercise, you will use the English unit system as you build the 
gyroscope model.

Changing the Unit System

 To change the default SI unit system to the English unit system:

1. Choose Numbers & Units in the World menu.

The Numbers & Units dialog appears, as shown in Figure 5-1.

Figure 5-1

Numbers & Units Dialog

2. Select the item “English (pounds)” from the Unit System list.

3. Click OK.

All the measurements in the simulation will be done in the English unit 
system for the remainder of the exercise, using inches for distance, 
pounds for mass, and seconds for time.

Unit System List
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Modifying the Edit Grid

Although the unit system is changed, the default workspace is scaled 
rather large for a small mechanism such as a gyroscope top, whose 
flywheel diameter will be approximately three inches. Each component 
would appear too small to manipulate.

In this step, you will modify the workspace to a more appropriate scale.

1. Choose Show Grid in the Grid menu.

The Edit Grid appears in the window, as shown in Figure 5-2

Figure 5-2

The Edit Grid

2. Choose Grid Settings in the Grid menu.

The Grid Settings dialog appears, as shown in Figure 5-3.
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Figure 5-3

Grid Settings Dialog

3. Type 5 into Grid Extents and 0.25 into Grid Snap edit boxes.

Note that the units in the dialog are based on inches because you 
selected the English unit system. Working Model 3D automatically 
scales the drawing window to accommodate the smaller Edit Grid.

4. Click OK to close the dialog.

The size of the Edit Grid shrinks on the document as shown in 
Figure 5-4.

5. Click the Zoom In/Out tool on the View toolbar.

The Zoom tool allows you to zoom into the document with a 
particular focus. The first mouse click becomes your focus for 
zooming.

6. Drag downward in the drawing window and release the mouse 
button when the Edit Grid fills a reasonable portion of your 
drawing window. 

See Figure 5-4 for an example.
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Figure 5-4

Document Zoomed In

If your Edit Grid does not appear to be quite centered, use the Pan tool to 
shift the view laterally.

Changing the Animation Step

By default, Working Model 3D sets the Animation Step as 0.02 second. 
In this step, you will make the Animation Step smaller than the default 
value since the gyroscope model in this exercise involves a flywheel that 
spins very rapidly.

1. Choose Accuracy in the World menu.

The Simulation Accuracy dialog appears (Figure 5-5).

Use the Zoom In/Out tool
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Figure 5-5

Simulation Accuracy Dialog

2. Enter the Animation Step as 0.005 seconds as shown in 
Figure 5-5.

Note that the two edit boxes located together in the Animation Step 
section of the dialog are inverses of each other. An Animation Step 
of 0.005 seconds corresponds to a frame rate of 200 frames per 
second.

5.2 Creating the Flywheel

The simple gyroscope in this exercise consists of a single flywheel and a 
rotation axle. In this section, you will create the flywheel:

1. Click the Cylinder tool on the Sketch toolbar.

2. Position the pointer anywhere on the Edit Grid and click the 
mouse button. Then move the mouse to expand the circle.

As you move the mouse, a circle appears on the Edit Grid.

3. Move the mouse around until the diameter of the circle reaches 
3 inches. Click the mouse button.

Notice how the coordinates bar shows the extent of the circle, as 
shown in Figure 5-6.

Enter 0.005 here
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Figure 5-6

Drawing the Flywheel

4. Move the mouse upwards slightly to extrude the circle. When 
the Coordinates bar shows that the thickness reaches 0.25 
inches, click the mouse button once again to complete the 
cylinder.

5.3 Creating the Rotation Axle

You can also specify a body’s geometry by describing its attributes in the 
Properties window. You will do so in this step as you create another 
cylinder for the rotation axle.

1. Click the Cylinder tool on the Sketch toolbar.

2. Click once on the Edit Grid, then press the Enter key on the 
keyboard.

A small cylinder appears on the Edit Grid. This cylinder also 
appears as body[2] in the Object List, which is displayed along the 
left side of the drawing window.

3. Double-click body[2] in the Object List (or click the right mouse 
button and select Properties from the menu that appears).

The Properties window for the cylinder appears, as shown in 
Figure 5-7.

Coordinates bar shows
the circle extent
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NOTE: If the small cylinder (body[2]) lies entirely within the larger 
cylinder, it is only possible to choose this body from the Object List.

Figure 5-7

Properties Window
(Position Page) for Rotation Axle

4. If it is not already selected, click the Position (Pos) tab, then 
enter the position of the rotation axle as (x, y, z) = (0, 0, 0).

5. Click the Geometry tab.

The Geometry page of the Properties window appears, as shown in 
Figure 5-8.

Figure 5-8

Properties Window 
(Geometry Page) for Rotation Axle

6. Enter 0.125 into the Radius and 4 into the height edit boxes.

Note that all the numbers are interpreted in inches.

7. Close the Properties window.



5.4 Attaching the Flywheel to the Rotation Axle 5-9

The cylinder is accordingly sized and positioned on the screen (see 
Figure 5-9).

Figure 5-9

Rotation Axle Sized 
and Positioned

5.4 Attaching the Flywheel to the Rotation Axle

To assemble the gyroscope top, you will use a revolute joint to attach the 
flywheel to the rotation axle so that the former freely rotates about the 
latter.

Coords and Constraints

All constraints (except for external forces and torques) in Working 
Model 3D consist of a pair of objects called Coords, each of which are 
attached to a body or the background. In essence, a Coord serves as a 
medium between a body and the constraint, as illustrated in Figure 5-10.
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Figure 5-10

Concept: Construction of a 
Constraint

In physical terms, a Coord is a point element with a coordinate system 
attached. Therefore, a Coord has position and orientation as properties.

For constraints such as spring dampers and separators, Coords serve as 
endpoints to those physical constraints.  For joints, Working Model 3D 
uses the orientation of the relevant Coords to determine the constraint 
conditions.

Chapter 4, “Creating a Piston Model”, provides more discussion on 
Coords and constraints.

Attaching a Coord to the Flywheel 

You will attach Coords to the flywheel and the rotation axle and create a 
revolute joint based on the two Coords.

To attach a Coord to the flywheel:

1. Click the Coord tool on the Sketch toolbar.

2. Click anywhere on the flywheel.

A Coord appears with a red circle and the coordinate axes. When 
selected, a Coord displays its triad with labels for x, y, and z axes, 
as shown in Figure 5-11.

To obtain a clear view of the Coord, you may wish to use the Zoom In/
Out or Rotate Around tools.

Body BodyConstraint

Coord Coord
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Figure 5-11

Coord on a Flywheel

3. Double-click the Coord in the drawing window or the Object 
List.

The Properties window appears.

4. If the position page is not displayed, click the Pos (position) tab.

 The Position page is displayed, as shown in Figure 5-12.

Figure 5-12

Properties Window 
(Position Page) for Coord

5. Verify that the position and orientation of the Coord are: (x, y, z) 
= (0, 0, 0.125), and (Rx, Ry, Rz) = (0, 0, 0).  If the values appear 
differently, type these values in the window to position the 
Coord precisely.

Coord symbol

Enter these values.
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The position and orientation of the Coord are expressed in terms of 
the coordinate system of the flywheel because the Coord is attached 
to it.

Attaching a Coord to the Rotation Axle

In this step you will attach another Coord to the rotation axle.

1. Click the Coord tool on the Sketch toolbar.

2. Click anywhere on the surface of the rotation axle.

A Coord appears with a red circle and the coordinate axes.

3. Double-click the Coord in the drawing window or the Object 
List.

The Properties window appears.

4. If the Pos (position) page is not displayed, click the Pos tab.

5. Enter the position and orientation of the Coord as follows: (x, y, 
z) = (0, 0, 0), and (Rx, Ry, Rz) = (0, 0, 0).

Again, the position and orientation of the Coord are expressed in the 
coordinate system of the rotation axle, which coincides with the 
global coordinate frame.

The Coord appears “buried” inside the rotation axle, as shown in 
Figure 5-13.
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Figure 5-13

Coord Positioned Inside the 
Rotation Axle

Creating a Revolute Joint

Now that the attachment points are ready, you will proceed to create a 
revolute joint connecting the two bodies.

1. Select “coord[4]” (the Coord attached to the rotation axle) in the 
Object List.

2. Press the Control key on the keyboard and select “coord[3]” 
(the Coord attached to the flywheel) in the Object List.

3. Click the Join/Create Constraint button on the Edit toolbar.

The Create Constraint window appears, as shown in Figure 5-14.

Coord
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Figure 5-14

Create Constraint Window

4. Select “Revolute Joint” as the joint type in the list of 
constraints.

The Create Constraint window is a versatile tool to create a constraint 
between a given pair of Coords.  The window presents different options 
depending on the type of objects that are currently selected.

The window is best understood when you read the first few lines of the 
window as a complete sentence.  In our case, the dialog reads:

“Create a Revolute Joint from coord[4] of body[2] to coord[3] of 
body[1].”

The bottom half of the Create Constraint window provides several 
options. For this exercise:

5. Choose the option labeled “Join (move body[2] to body[1])”.

The option indicates that body[2] (the rotation axle) will be moved 
to body[1] (the flywheel), so that the two Coords will be aligned.

6. Click the Create button located at the bottom of the window.

The rotation axle is moved to the flywheel, and the revolute joint 
icon appears at the attachment points, as shown in Figure 5-15.
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Figure 5-15

Assembled Gyroscope

Note that the rotation axle was moved to the flywheel, because you 
selected the rotation axis first. For joint constraints, the order of selection 
thus affects the assembly behavior. 

By default, Working Model 3D creates a revolute joint by allowing a 
single degree of freedom in rotation about the z-axes of the two Coords.  
Therefore, when you created a revolute joint, note that Working Model 
3D aligned the following:

• the origins of the two Coords, and

• the z-axes of the two Coords (in the same direction).

As shown in Figure 5-16, the two Coords will not necessarily be aligned 
completely, as the revolute joint allows free rotation about the z-axes.
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Figure 5-16

Aligning Coords for a Revolute 
Joint

Other joints available in Working Model 3D follow principles similar to 
the revolute joint.  For example, a spherical joint is constructed by 
aligning the origins of two Coords; since the joint allows three rotational 
degrees of freedom, the coordinate axes need not be aligned.  The next 
section illustrates how to construct a spherical joint.

5.5 Attaching the Gyroscope to the Ground

In this step, you will fix the bottom end of the gyroscope axle to the 
ground through a spherical joint to allow three degrees of freedom in 
rotation.

Tilting the Gyroscope

The gyroscope is currently in an upright position. To observe precession, 
in this step you will tilt the gyroscope slightly.

1. Double-click anywhere on the rotation axle (make sure you do 
not click the flywheel) or on “body[2]” in the Object List.

The Properties window appears.

2. Click the Pos (position) tab.

The Position page is displayed, as shown in Figure 5-17.

3. In the field Ry (orientation about the y-axis), enter 15.

x2

y2

z2

x1

y1

z1

x2

y2

z1, z2 y1

x1

Two distinct Coords in space
before creating a revolute joint

For a revolute joint,
origin and z-axes of the
Coords are aligned.
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The gyroscope tilts by 15 degrees about the y-axis of the axle.

Figure 5-17

Properties Window 
for the Rotation Axle

Note that the flywheel also tilted by 15 degrees and preserved the 
revolute joint constraint connecting the rotation axle and the flywheel. 
As a result, the entire gyroscope tilted by 15 degrees.

Notes on Body XYZ Angle It is important to understand that the body was rotated about the y-axis 
of the body’s frame, not of the global frame because Working Model 3D 
expresses the orientation of a body in Body XYZ angles. Body XYZ 
angles represent the orientation of a body with three parameters (X, Y, 
and Z angles). Initially, the body is oriented so that its coordinate system 
orientation matches that of the global frame.

Given the X, Y, and Z angles, the body is rotated first by X, with the 
body’s x-axis fixed in space.  Then the body is rotated by Y, with the 
body’s y-axis fixed in space.  Finally, the body is rotated by Z, with the 
body’s z-axis fixed in space.

For example, if the Properties window of a box has a parameter (Rx, Ry, 
Rz) = (20, 45, 30), then Working Model 3D represents the orientation of 
the box as shown in Figure 5-18.

Type 15 here
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Figure 5-18

Body XYZ Angle Example

Creating an Attachment Point on the Ground

You will attach the gyroscope assembly to the ground using a spherical 
joint. To create the joint, you will take steps similar to the ones taken 
when creating the revolute joint.

1. Click the Coord tool on the Sketch toolbar.

2. Click anywhere on the Edit Grid, away from the bodies.

A Coord automatically attaches to the xy plane.

3. Double-click the Coord in the drawing window or the Object 
List.

4. If the Pos (position) page is not displayed, click the Pos tab.

5. Enter these values to locate the Coord at the global origin. That 
is, (X, Y, Z) = (0, 0, 0) and (Rx, Ry, Rz) = (0, 0, 0).

The Coord immediately moves to the global origin.

(1) Unrotated
(2) Rotated 20 degrees

(3) Rotated 45 degrees (4) Rotated 30 degrees
about the body’s y-axis

about the body’s x-axis

about the body’s z-axis

(Aligned with Global Frame)
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Creating an Attachment Point on the Gyroscope

To attach another Coord at the bottom of the rotation axle, you will need 
to look at the bottom.

1. Choose New Window in the Window menu.

The second window appears, presenting the view of the gyroscope 
model from the same view angle.

Working Model 3D allows you to open multiple windows for a single 
document. As shown below, individual windows can have completely 
independent view angles, yet any changes to the model are updated in all 
windows simultaneously. 

2. Choose Tile in the Window menu.

The two windows are repositioned and appear side-by-side.

You can resize the Object Manager pane of either or both windows to 
make more room available for the drawing pane by dragging the vertical 
lines that separate the panes. 

3. Click the Rotate Around tool on the View toolbar.

The mouse pointer changes its shape accordingly. Alternatively, you 
can select the Rotate Around tool by pressing F4 on the keyboard.

4. On the right window, click anywhere on the rotation axle and 
hold the mouse button.

Note that the view in the left window remains unchanged.

5. Drag the mouse so that the bottom end of the rotation axle is 
facing you.

See Figure 5-19 as an example.
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Figure 5-19

Multiple Windows Placed Side-by-
Side Showing Different Angles

6. Click the Coord tool on the Sketch toolbar.

7. Click at the bottom end of the rotation axle.

Note that the left window also shows the Coord is attached.

8. In the Properties window, verify that the position and orientation 
of the Coord are (X, Y, Z) = (0, 0, -2.0) and (Rx, Ry, Rz) = (0, 180, 
0).

Creating a Spherical Joint

You will connect the last two Coords with a spherical joint.

1. In either window, select coord[7] (the Coord attached to the 
bottom end of the rotation axle).

Note that the Coord appears selected on both right and left windows.

2. In either window, hold the Control key down and select coord[6] 
(the Coord attached to the background at the global origin).

Note that the two Coords are selected in both windows.
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3. Click the Join/Create Constraint button on the Edit toolbar.

The Create Constraint window appears.

4. Select “Spherical Joint” as the constraint type.

5. Choose the option labeled “Join (move body[2] to coord[6])”.

The option indicates that body[2] (the rotation axle) will be moved 
to coord[6] (the background), so that the two Coords will be aligned 
(see below for more information).

6. Click the Create button located at the bottom of the window.

The gyroscope is moved, and the spherical joint icon appears at the 
attachment point, as shown in Figure 5-20.

Figure 5-20

Gyroscope Attached 
to the Ground

When creating a spherical joint, Working Model 3D makes an effort to 
align the coordinate origins of the two Coords. However, since a 
spherical joint allows all three degrees of rotation, the orientation of each 
Coord remains unchanged before and after the joint is created.
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In the same light, note that the entire gyroscope assembly is translated so 
that the attachment points are aligned, but it was not rotated. It was only 
necessary to align the position of the Coords, but not their orientations. 
Figure 5-21 illustrates this principle. Compare it with Figure 5-16 which 
describes the principles of the revolute joint.

Figure 5-21

Aligning Coords for a Spherical 
Joint

5.6 Giving Initial Spin to the Gyroscope

To observe precession, the gyroscope must have an initial angular 
velocity.

1. Double-click the flywheel, body[1], in the drawing window or the 
Object List.

1. Click the Vel tab in the Properties window.

The Properties window shows the initial velocity and angular 
velocity of the flywheel.

2. To specify the angular velocity about the z-axis of the flywheel, 
enter Wz = 14400, as shown in Figure 5-22.

The angular velocity of a body is specified in terms of the body’s 
coordinate axes. Since the flywheel is to spin about its z-axis, you are 
specifying the angular velocity in the z-axis (ωz). In this case, the angular 
velocity of 14400 degrees per second corresponds to 2400 rpm.

x2

y2

z2

x1

y1

z1

Two distinct Coords in space
before creating a spherical joint

For a spherical joint, only
the origins of the Coords
are aligned, while their

x1

y1

z1

x2

y2

z2

orientations are preserved.
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Figure 5-22

Assigning Initial Angular Velocity

5.7 Running the Simulation

To better observe the precession (in which the axle slowly rotates about 
the global z-axis), you will prepare another view angle of the model.

1. Click once in the blank area of the right window.

2. Press “T” on the keyboard.

The window provides the “top view” of the model, as shown in 
Figure 5-23. The keyboard shortcut “T” stands for “top view.” 

Type 14400 and press Enter. The number
format is automatically converted to 1.44e+4.
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Figure 5-23

Getting the Top View

3. Click the Run button in the Tape Player control.

Run the simulation for approximately two hundred frames. Observe that 
the gyroscope exhibits the precession while the flywheel undergoes a 
rapid rotation.

4. After running for about 200 frames, click the Reset button.

Working Model 3D resets the simulation to the initial condition, but 
the simulation data is still stored in memory.

5. Click the Run button again.

Note that the simulation seems to run much faster the second time 
around.  Working Model 3D stored the simulation history from the 
previous run, and it is simply playing back the data.  As soon as the tape 
player control’s frame indicator reaches the rightmost edge, Working 
Model 3D will need to recompute, and the apparent speed of the 
simulation slows down.

6. After running for about 200 frames, click the Reset button.
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5.8 Displaying the Angular Velocity Vector

Working Model 3D allows you to visualize the dynamics of a simulation 
by displaying vectors as the simulation runs. In this step, you will display 
the angular velocity of the rotational axle to emphasize the precession of 
the gyroscope. 

1.  Double-click body[2], the rotation axle, in the Object list.

The rotation axle’s properties appear in the Properties window.

2. Click the right arrow in the Properties window to scroll the tabs 
until the Vectors tab is displayed, then click the Vectors tab.

The Vectors page is displayed, as shown in Figure 5-24.

Figure 5-24

Properties Window 
(Vectors Page) for the Rotation 
Axle

3. Click the Rot. Velocity Vector box to put a checkmark in it.

4. Close the Properties window.

5. Click the Run button in the Tape Player Control.

As the simulation runs, the rotational velocity vector is displayed, as 
shown in Figure 5-25.



5-26 Exercise 5—Modeling a Gyroscope Top

Figure 5-25

Rotational Velocity Vector

6. Click the Stop button, then reset the simulation by clicking the 
Reset button.

The gyroscope returns to the initial position.

Rotational Velocity Vector
on Rotation Axle
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